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Optimizing Drug Therapy in 
the Elderly
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DRUGS ARE POISONS 
WITH THERAPEUTIC 

SIDE EFFECTS!!!

What is “elderly” anyway?

Germany established 65 as the age to 
receive benefits from their “social security” 
system.
U.S. adopts this same age for its social 
security.
Chronologic age   versus   Physiologic age
Better delineation of aging population
65-75 “younger-old” 76-85 “older-old”
86+ “oldest-old”
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Physiologic Reserves 
Already in Use

Physiologic 
Reserves 
Available

Increasing Age

The Precipice

Demographics

1900 - 1 in 25 Americans older than 65
1984 - 1 in 8
2050 - 1 in 4.6
Life expectancy: Men Women

1950 65.6 71.1
1990 72.7 79.5

Chronic illness
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Comorbidity Increases with Age

40%
34%

28%
24%26%

18% 15%

54%
62%

0%

10%

20%

30%

40%

50%

60%

70%

60's 70's 80's

2 or more Dx
1 disease
0 disease

Age Ranges

Guralnik JM et al. 
Advance Data Report 
170. 1989.

Leading Causes of Death
65 years and older

Heart disease
Cancer
Stroke
Chronic obstructive pulmonary disease
Pneumonia and influenza
Diabetes

Medication Use
Persons  > 65 y/o consume 25-40% of all 
prescription items
40-50% of all OTC medications
1/3 of annual healthcare cost ($300 billion)
Issues relating to “polypharmacy”
» Cost
» Adverse Drug Reactions
» Drug Interactions
» Hospital Admissions
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Impact of Drug-Related Problems
30% of hospital admission in elderly can be linked to 
ADE’s

» Horton JT, et al.  J Am Geriatr Soc 1997;45:945-948

ADE’s  linked to preventable problems in the elderly 
such as depression, constipation, falls immobility, 
confusion & hip fractures
» Bootman JL, et al.  Arch Intern Med; 157:2089-2096

35% of ambulatory older adults experience ADE and 
29% required health care services
» Cooper JW, Sough Med J 1999; 92:586-490

67% of nursing facility residents have ADE’s, 1 of 7 
require hospitalization.
» Cooper JW J Am Geriatr Soc: 1999;195-197

Polypharmacy Risk

Number of Medication Risk
2 - 5 4%
5 - 8 50%
> 8 100%

Sloan RW, Practical geriatric therapeutic. Oradel, NJ: Medical Economics Books, 1986:39-50.

Polypharmacy, Adverse Drug-Related Events, and Adverse 
Drug Interactions in Elderly Patients Presenting to an ED

Hohl CM, et al, Annals of Emergency Medicine 2001;38(6):666-671

300 randomly selected charts of patients 65 years and 
older
90.8% of patients were taking 1 or more regular OTC or 
prescribed medications
» mean regular medication = 4.2 drugs/patient

Adverse drug related evens accounted for 10.6% of all 
ED admissions
» 1 med 0%; 2-5 meds 11.5%; > 6 meds 16.9% 

31% of patients had a Possible drug related event 
present in their drug regimen
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Polypharmacy, Adverse Drug-Related Events, and Adverse 
Drug Interactions in Elderly Patients Presenting to an ED

Hohl CM, et al, Annals of Emergency Medicine 2001;38(6):666-671

Most Frequently Implicated Drug Groups
» NSAID
» Diuretics
» Hypoglycemics
» Beta-Blockers
» Calcium-channel blockers
» Chemotherapeutic

To Err Is Human: 
Building a Safer Health System
Kohn L, et al. Institute of Medicine (IOM) 1999 Report

Medications related problems causes 
106,000 deaths annually
Resulting Cost: $8 billion annually

Other Costs Associated With 
Medication Related Problems

Ambulatory Care:  $77 billion annually
» Bootman JL, et al.  Arch Intern Med; 157:2089-2096

Hospitals: $20 billion annually
» Bates DW, et al. JAMA 1997; 277: 307-311

Nursing Home Facilities: $4 billion 
annually
» Johnson JA et al. Arch Intern Med 1995; 155: 1949-1956
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Physiologic Changes with Aging
Body Composition
Cardiovascular System
Central Nervous System
Digestive System
Renal System
Hepatic System
Endocrine System
Skeletal System

Physiologic Determinants of Drug 
Distribution

Absorption Elevated gastric pH
Decreased GI blood flow
Decreased active transport

Distribution Decreased total body water
Increased body fat
Decreased serum albumin

Metabolism Decreased liver blood flow
Possibly decreased enzyme activity

Excretion Decreased renal blood flow
Decreased glomerular filtration rate

Wide Therapeutic Window

Toxic Range

Serum Therapeutic Range
Conc

Subtherapeutic Range
Time
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Narrow Therapeutic Window

Toxic Range
Serum
Conc Therapeutic Range 

Subtherapeutic Range

Time Digoxin, quinidine, procainamide, warfarin, 
phenytoin, theophylline, carbamazepine, 
aminoglycosides, lithium, cyclosporin

Therapeutic Window

Toxic Response

Age

Age Effect on Therapeutic Window

Distribution

Water : Lean Body Mass : Fat   Distribution
» Infants: Higher per cent water

– water soluble drugs- larger dose per weight
Antibiotics

» Elderly: Higher per cent fat
– lipid soluble drugs- smaller dose per weight

Benzodiazepines  (Diazepam, Chlordiazepoxide vs. 
Lorazepam, Oxazepam)

Serum Albumin
» Decreased in elderly person

– Combinations of highly protein bound drugs
Warfarin , Phenytoin, Sulfonamide Antibiotics
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Altered Distribution
Protein Binding
» Drugs highly bound to serum albumin (>90%) 

can be affected by other highly protein bound 
drugs, competing for the same binding sites

» Only free drug (unbound drug) is active
– If only 5% of the total serum drug level is free (and 

active) any changes can have a significant effect on 
circulating free drug

Changes in serum circulating albumin and 
protein concentrations.

Phenytoin (Dilantin, 10-20 mcg/ml)

Measured Patient’s Serum Albumin (gm/dl)
Phenytoin 3.5 3 2.5 2
(mcg/ml)  Adjusted Total Phenytoin Conc (mcg/ml)

5 6 7 8 10

10 13 14 17 20

15 19 21 25 30
Winter-Tozer Equation Conc (adjusted)=   Conc (observed)__

(0.2 x albumin) + 0.1

Age Related Decrease in Renal Function

Loss of glomeruli
» Demonstrated 46% decline in inulin 

clearance from age 20 to 90
Decreased renal blood flow
Decrease in tubular function
Decreased concentrating ability
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Graphic Representation of 
Decreased Renal Elimination

Cockcroft-Gault Equation
Estimation of Creatinine Clearance

Men
Estimated Creatinine Clearance (ml/min)=

(140-age) x Body Wt  in Kg
72 x Serum Creatinine

Women 
0.85 x above value

Digoxin (Lanoxin)

Renally cleared; long half-life - 42 hours
CNS effects common
» blurred vision, altered cognition, depression

GI effects:anorexia, nausea
Periodic serum level monitoring
» blood levels versus therapeutic effect

treat patient NOT THE NUMBERS
CHF versus atrial fib rate control
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Anticholinergic Side Effects

Peripheral Effects
» Dry Mouth
» Mydriasis
» Constipation
» Tachycardia
» Urinary retention
» Thermoregulatory 

Impairment

Central Effects
» Sedation
» Confusion
» Delirium
» Dizziness

Commonly Used Medications with 
Anticholinergic Side Effects

Antidepressants
» Amitriptyline (Elavil)
» Imipramine (Tofranil)

Antihistamines
» Diphenhydramine
» Chlorpheniramine 

Antivertigo
» Scopolamine (TransDerm Scop)

» Meclizine (Antivert)

Antidiarrheals
» Diphenoxylate (Lomotil)

Antiarrhythmics
» Disopyramide (Norpace)

Antiemetics
» Prochlorperazine 
» Promethazine (Phenergan)
» Hydroxyzine (Atarax)

Urinary Antispasmodics
» Oxybutynin (Ditropan)

Antipsychotics
» Chlorpromazine (Thorazine)
» Haloperidol (Haldol)
» Fluphenazine (Prolixin)

Muscle Relaxants
» Cyclobenzaprine (Flexeril)
» Orphenadrine (Norflex)

Nonsteroidal 
Antiinflammatory Agents

Effect on the GI System
» Inhibition of protective prostaglandins leading to 

gastritis, symptomatic/ asymptomatic bleeding
Effect on the Renal System
» Inhibition of renal prostaglandins required when 

renal blood flow is decreased resulting in 
reversible acute renal failure, sodium retention, 
hypertension, increases in BUN/Cr

» Meta analysis of 54 published studies (N=1324)
– Greatest effect Naproxen, Indomethacin
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Considerations for NSAID Use in 
the Elderly

GI side effect generally well known
Decreased renal function, sodium and water 
retention ARE OFTEN UNDER-RECOGNIZED
Adverse effects are often dose related
» adjust starting dose down and advance slowly

COX-2 Inhibitors may be safer. 
» Rofecoxib (Vioxx); celecoxib (Celebrex), Valdecoxib (Bextra)

Routine acetaminophen a possible alternative. 

Benzodiazepines

Side effects often associated with 
differences in fat:water solubility and 
production of active metabolites

Diazepam Lorazepam
Chlordiazepoxide > Oxazepam
Flurazepam Temazepam

Anxiolytic and Hypnotic
Use in the Elderly Considerations

Avoid long half-life benzodiazepines with 
active metabolites
» Diazepam (Valium), Chlordiazepoxide (Librium), Chlorazepate 

(Tranxene)
» Flurazepam (Dalmane), Temazepam (Restoril)
» Diphenhydramine (Benadryl) for sedation generally a BAD IDEA

Use shorter, “clean” half-life agents at adjusted 
doses with caution (ADR’s, “drug hang-over”
» lorazepam (Ativan), Oxazepam (Serax)
» zolpidem (Ambien), estazolam (ProSom)
» triazolam (Halcion)…. Safe????
» eszopiclone (Lunesta), data on new sedative in the elderly equate to 

more safe medication (?)
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Side Effects

Sedation Ataxia
Delirium Amnesia
Dizziness Hangover effects
Confusion Slurred speech
Dysphoria Paradoxical excitement
Diplopia Blurred vision
Hypotension Bradycardia
Dependence rate

Histamine-2 Receptor 
Antagonists

Low renal clearance associated with CNS side 
effects:
» Dizziness Somnolence Confusion
» Agitation Arrhythmias

Cimetidine>Ranitidine>Nizatidine>Famotidine
All side effects are dose related and resolve with 
discontinuation or dose adjustment.
Proton Pump Inhibitors - very expensive for general 
use
» omeprazole (Prilosec), lansoprazole (Prevacid), 

rabeprazole (AcipHex), pantropazole (Protonix)

Treatment of Depression
Tricyclics
» Anticholinergic side effects
» orthostatic hypotension

Bad: amitriptyline (Elavil), doxepine (Sinequan)
Better: nortriptyline (Pamelor)
SSRI’s; fluoxetine (Prozac), sertraline (Zoloft), fluvoxamine
(Luvox), citalopram (Calexia)
» Safer and fewer side effects, BUT don’t get a false sense of 

security.
» GI distress, anorexia, weight loss, CNS stimulation

DRUG INDUCED CAUSES OF DEPRESSION AND TRUE 
CLINICAL DIAGNOSIS
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Beers MH, et al. “Explicit Criteria for 
Determining Inappropriate Medication Use in 
Nursing Home Residents”.  Arch Intern Med. 

1991;151:1825-1832,
Two round survey of 13 experts in the field of 
geriatric medicine
Agreed on 30 factors defining “inappropriate 
use”
Criteria on the use and dose of:
» Sedative-hypnotics Antidepressants
» Antipsychotics Antihypertensive
» NSAID’s Oral hypoglycemics Analgesics
» Platelet Inhibitors H-2 blockers Antibiotics

Criteria for Inappropriate Use
Beers. Arch Intern Med 1991;151:129

Sedative-hypnotics
» chlordiazepoxide, 

diazepam, flurazepam
» Meprobamate
» Any use > 4 weeks

Antidepresants
» Avoid Amitriptyline
» Avoid combinations

Antipsychotics
» Haloperidol > 3mg/day
» Thioridazine >30mg/day

Antihypertensives
» HCTZ > 50mg/day
» Avoid Methyldopa, 

Propranolol, Reserpine 
Oral Hypoglycemics
» Avoid Chlorpropamide

Analgesics
» Avoid Propoxyphene
» Avoid Pentazocine

Dementia treatments
» Avoid cyclandelate
» Avoid Isoxsuprine

Criteria for Inappropriate Use
Beers. Arch Intern Med 1991;151:129

Histamine Blockers
» Cimetidine  >900mg/day
» Ranitidine >300mg/day

Antibiotics
» Use >4 wks with 

exceptions
Decongestants
» Afrin, Neo-Synephrine, 

Sudafed  use > 2 weeks

Iron
» Doses > 325mg/day

Platelet Inhibitors
» Avoid Dipyridamole

Muscle relaxants
» Avoid Cyclobenzaprine, 

Carisoprodol, 
Methocarbamol

GI antispasmodics
» Avoid long term 

Donnatal, Levisin, Pro-
Banthine.

Antiemetics
» Avoid Tigan

NSAID
» Avoid Indomethacin 

Phenylbutazone
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Beers MH, et al. “Inappropriate Medication 
Prescribing in Skilled-Nursing Facilities”. 

Ann of Intern Med 1992;117:684-689.

Applied criteria of “inappropriate use” to 
a total of 1106 nursing home residents
40% of residents received at least one 
of the medications meeting criteria
10% received 2 or more
7% of all prescriptions were 
“inappropriate” by their criteria.

Beers MH, et al. “Inappropriate Medication 
Prescribing in Skilled-Nursing Facilities”. 

Ann of Intern Med 1992;117:684-689.

51% of “inappropriate” use was with 
agents expert agreed should generally 
be “avoided”.
34% involved drugs with limitation on 
duration of use
15% involved doses exceeding 
recommended dose limits

Inappropriate Drug Prescribing for 
the Community-Dwelling Elderly

Using the 1987 National Medical Expenditure 
Survey (n=35,000 patients)
Incidence of prescribing 20 potentially inappropriate 
drugs as defined by Beers
32%% of patients >65 received at least one of the 
20 contraindicated medications (6.4 million pts)
20.4% received two or more
dipyridamole, diazepam, indomethacin, chlordiazepoxide, 
propranolol, methyldopa, reserpine

Willcox SM et al. JAMA 1994; 272 (4):292-296
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Explicit Criteria for Determining Potentially Inappropriate 
Medication Use by the Elderly: An Update

Beers MA Arch Intern Med 1997; 157:1531-1536

Four goals established
» Reevaluate the criteria to include new 

products and incorporate new information 
available in the scientific literature

» Generalize the criteria to a population of 
persons older than 65 y/o regardless of the 
level of frailty or place of residence

» Assessing a relative rating of severity
» Identify additional alerts specific diagnosis

Updating the Beers Criteria for Potentially Inappropriate 
Medications Use in Older Adults

Fick DM, et al. Arch Intern Med 2003; 163:2716-2724

Reevaluate the 1997 criteria include 
new products and incorporate new 
information available from scientific 
literature
To assign or revaluate a relative rating 
or severity for each medication
Identify new conditions or considerations 
not addressed in 1997

Application of Beer’s Criteria

Criteria is not without controversy 
» To simplistic, cannot take into account 

special needs of individual patient
» Limiting the freedom of physician to 

prescribe
Criteria based prescribing 
recommendations need to be continually 
updated to be effective and usable
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Other Proponents of Explicit 
Prescribing Criteria

Institutes of Medicine
Center for Medicare Service (CMS)
Agency for Healthcare Research and Quality (AHRQ)
HEDIS Measure for 2006
American Association of Healthcare Plans (AAHP)
» Managed care organizations
» Pharmacy Benefits Managers

State Medicaid Programs
Computer software vendors
» “Rules engines” for computer order entry

Plaintiff's Legal Council 

HCFA Medication Use Guidelines
Medications to avoid (except under specific 
circumstances); Option for use of other med.
» Doxepine (Sinequan)
» Pentazocine (Talwin)
» Disopyradamide (Norpace)
» Methyldopa (Aldomet)
» Chlorpropamide (Diabenese)
» Barbiturates for sedative/hypnotic
» Meperidine (especially orally) 

HCFA Medication Use Guidelines
Medications to avoid (except under specific 
circumstances); Option for use of other med.
» Phenylbutazone (Butazolidin)
» Trimethobenzamide (Tigan)
» Dipyridamole (Persantine)
» Reserpine
» Ergot mesyloids (Hydergine) for dementia
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HCFA Medication Use Guidelines
Medications for use with limitation
» Amitriptyline (Elavil) - neurogenic pain
» Digoxin - Dose 0.125mg for CHF; 0.25 Atr Fib
» Ticlopidine (Ticlid) - only in documented ASA allergy
» NSAID in GI disease
» Antiplatelet agents in anticoagulated states
» Diphenhydramine for sleep - < 7 doses/ quarter
» Muscle relaxants (baclofen, cyclobenzaprine) 

< 7 doses/quarter
» Dose limitation on all antipsychotic agents
» Various medications for insomnia- < 7 consecutive days

Assessing Care of Vulnerable 
Elders (ACOVE)

Evaluate the PROCESS for caring for 
the elderly
Establishment of valid evidence-based 
measures of quality for frequently 
encounter health issues.
Still the measure may not fill the needs 
of all elderly patients.

Assessing Care of Vulnerable Elders 
(ACOVE)

Annals of Internal Medicine October 16, 2001;135 (8,part 2)

End-of-life care
Falls and mobility 
disorders
Hospital care
Hearing impairment
Malnutrition
Osteoarthritis
Pain Management
Pressure ulcers
Urinary Retention

Dementia
Depression
Diabetes mellitus
Heart failure
Hypertension
Ischemic heart disease
Pharmacologic management
Pneumonia and influenza
Screening and prevention
Stroke and atrial fib
Vision Impairment



18

The Prescribing Cascade

Arthritis

NSAID
Increased

BP

Antihypertensive
Depression

Anticholinergic
Antidepressant

Constipation

Laxative

Initial Condition Therapy New Symptom Subsequent
Therapy

Gurwitz JH, Optimizing Drug Therapy in the 
Elderly. Pharmacy & Therapeutics, 1997;

22:331-347

Practical Issues in Drug Use in 
the Elderly

Drug Regimen Review
» DC therapy for condition that no longer exist
» Reduction in dosage

– Dosing based on renal function
– Start Low and Go Slow

» Treatment  of two conditions with single agent
– Hypertension; Heart Disease; BPH; Renal Disease

» Assess OTC, vitamins, herbal supplements
» Review Rx containers for accuracy and clarity of 

directions.

Practical Issues in Drug Use in 
the Elderly (con’t)

Recognizing Adverse Drug Events
» Misinterpretation of ADR as a medical condition
» Avoiding the “Prescribing Cascade”

Use of Safest Possible Drug
» Long vs. short half-life drugs

Identify the Lowest Feasible Dose
» Potential for side effects and cost
» Knowledge base of patient about medications

– “Tell me what you take this medication for”
» CLEAN OUT THE MEDICINE CABINET
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Practical Issues in Drug Use in the Elderly

Problems of Nonadherence
» Compliance under the best of conditions is 

approximately 50%
» Premature discontinuation
» Excessive consumption
» Visual impairment, functional disability and 

cognitive dysfunction
– Written and/or verbal medical illiteracy 

» Misunderstanding of written/verbal instructions
» Use of weekly pill-box reminders


